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1. Overview

Version 1.2 of J∆S Engineering Suite introduces four major features that extend the software beyond the desktop GUI: a

command-line interface for headless calculations and automation, an automatic update system, a comprehensive offline

help system, and a full-featured web dashboard for project management and team collaboration.

This guide covers each feature in detail with step-by-step instructions, practical examples, and configuration options.

2. CLI / Batch Runner
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2.1 What Is the CLI Runner?
The CLI Runner (cli_runner.py) lets you run load calculations, energy simulations, and compliance checks from the

command line without launching the graphical interface. This is useful for:

• Parametric studies: Sweep a design parameter across multiple values and compare

results.

• CI/CD integration: Run compliance checks automatically when a project file

changes.

• Scripted automation: Chain calculations with other tools in a build pipeline.

• Server-side processing: Run calculations on a headless server or in a Docker

container.

2.2 Basic Usage
The general syntax is:

python cli_runner.py <command> <arguments> [options]

You can also check the installed version:

python cli_runner.py --version

2.3 The Five Subcommands

2.3.1 load-calc -- Heating and Cooling Load Calculations

Runs ASHRAE CLTD/CLF room-by-room load calculations for every room in the project (or a single room if --room is

specified).

Syntax:

python cli_runner.py load-calc <project.mep> [options]

Options:

Option Short Description

--output <path> -o Write results to a file instead of stdout

--format <fmt> -f Output format: json (default), csv, or
summary

--room <id> -r Calculate only this room (by ID or name)

Example -- Full project in JSON:

python cli_runner.py load-calc "C:\Projects\office.mep" -o results.json

Example -- Single room as CSV:

python cli_runner.py load-calc "C:\Projects\office.mep" --room "Lobby" -f csv -o lobby.csv



J∆S Engineering Suite Guide 10 New Features v1 2

J∆S Engineering Suite v1.2 — Sample Project User Guide Page 4

Example -- Quick summary to the terminal:

python cli_runner.py load-calc "C:\Projects\office.mep" -f summary

The JSON output includes project-level totals (total cooling tons, total heating MBH, total CFM) and a rooms array with

per-room breakdowns including cooling sensible, cooling latent, heating, supply CFM, ventilation CFM, and intensity

metrics (BTU/hr per ft2, CFM per ft2).

2.3.2 energy-sim -- 8760-Hour Annual Energy Simulation

Runs a full annual energy simulation using weather data for the project location.

Syntax:

python cli_runner.py energy-sim <project.mep> [options]

Options:

Option Short Description

--output <path> -o Write results to a file instead of stdout

--format <fmt> -f Output format: json (default), csv, or
summary

Example:

python cli_runner.py energy-sim "C:\Projects\office.mep" -o annual_energy.json

The output includes monthly energy breakdowns, peak demand, EUI (kBtu/ft2-yr), and unmet hours tracking.

2.3.3 compliance -- Code Compliance Check

Checks the project against a specified energy code standard.

Syntax:

python cli_runner.py compliance <project.mep> [options]

Options:

Option Short Description

--standard <code> -s Standard to check: ashrae90.1 (default),
title24, or ufc

--output <path> -o Write results to a file instead of stdout

--format <fmt> -f Output format: json (default), csv, or
summary

Example -- ASHRAE 90.1 check:

python cli_runner.py compliance "C:\Projects\office.mep" -s ashrae90.1 -o compliance.json

Example -- Title 24 check:

python cli_runner.py compliance "C:\Projects\office.mep" -s title24 -o t24_check.json
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The JSON output includes the standard name, climate zone, overall pass/fail status, and an array of individual checks

showing the code reference, required value, actual value, units, pass/fail status, and notes.

2.3.4 info -- Project Summary

Prints a formatted project summary to the terminal including project metadata, zone and room counts, total loads, and a

room listing.

Syntax:

python cli_runner.py info <project.mep>

Example:

python cli_runner.py info "C:\Projects\office.mep"

Sample output:

============================================================
J∆S Engineering Suite - Project Summary
============================================================
Project Name: Main Street Office Building
Project Number: 2026-001
Location: San Diego, CA
Climate Zone: 3B
Gross Area: 50,000 ft2

Systems: 3
Zones: 12
Rooms: 24

Total Cooling: 125.4 tons (1,504,800 BTU/hr)
Total Heating: 450.2 MBH (450,200 BTU/hr)
Supply CFM: 42,500
Ventilation CFM: 12,800

Summer Outdoor: 89F DB / 68F WB
Winter Outdoor: 44F DB
Indoor Summer: 75F
Indoor Winter: 70F
============================================================

Rooms (24):
ID Name Type Area (ft2)
---------- ------------------------- -------------------- ----------
R-101 Lobby Office 1,200
R-102 Open Office Office 5,000
...

2.3.5 batch -- Parametric Sweep

Runs multiple load calculations with one design parameter varied across a range of values. This is the most powerful CLI

feature, ideal for envelope optimization studies and sensitivity analyses.

Syntax:

python cli_runner.py batch <config.json> [options]

Options:
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Option Short Description

--output <path> -o Output file (overrides the config file setting)

--format <fmt> -f Output format (overrides the config file
setting)

Batch Configuration File:

The config file is a JSON document with three sections:

{
"project": "C:\\Projects\\office.mep",
"sweep": {
"parameter": "wall_r_value",
"values": [10, 13, 19, 21, 25, 30],
"apply_to": "all_rooms"
},
"output": {
"format": "json",
"file": "wall_study_results.json"
}
}

Supported Sweep Parameters:

Parameter Description Example Values

wall_r_value Wall insulation R-value [10, 13, 19, 21, 25, 30]

roof_r_value Roof insulation R-value [15, 20, 25, 30, 38]

window_shgc Window solar heat gain coefficient [0.25, 0.30, 0.35, 0.40]

window_u_value Window U-factor [0.25, 0.30, 0.35, 0.45]

cooling_setpoint Cooling thermostat setpoint (F) [72, 74, 75, 76, 78]

heating_setpoint Heating thermostat setpoint (F) [68, 70, 72]

supply_air_temp Supply air temperature (F) [52, 55, 58]

cooling_safety_factor Cooling load safety factor [1.0, 1.05, 1.10, 1.15]

heating_safety_factor Heating load safety factor [1.0, 1.10, 1.20]

Example -- Wall insulation study:

1. Create a file called wall_study.json:

{
"project": "office.mep",
"sweep": {
"parameter": "wall_r_value",
"values": [10, 13, 19, 21, 25, 30],
"apply_to": "all_rooms"
},
"output": {
"format": "csv",
"file": "wall_study.csv"
}
}
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2. Run the sweep:

python cli_runner.py batch wall_study.json

3. Open wall_study.csv in Excel to plot cooling load vs. R-value.

2.4 Output Formats
All subcommands (except info) support three output formats:

Format Description Best For

json Full structured JSON with all fields Programmatic consumption, archival

csv Comma-separated values (rooms or sweep
runs)

Spreadsheet analysis, Excel import

summary Human-readable text summary Quick terminal review

2.5 Piping and Scripting
Because the CLI writes results to stdout by default (progress messages go to stderr), you can pipe results into other tools:

python cli_runner.py load-calc project.mep -f json | python my_analysis.py

Or redirect to a file:

python cli_runner.py load-calc project.mep -f csv > loads.csv

2.6 Troubleshooting

Problem Solution

"Project file not found" Use an absolute path or verify the .mep file exists

"Expected a .mep project file" Ensure the file has the .mep extension

"Could not deserialize project" The project file may be corrupt or from an older version

"energy_simulation module not available" Install the required dependencies: pip install -r
requirements.txt

Batch "Unknown sweep parameter" Check the parameter name against the supported list in Section 2.3.5

3. Auto-Update System

3.1 How Updates Work
J∆S Engineering Suite automatically checks for new versions once per day when the application starts. The check runs

silently in a background thread so it never blocks the user interface. If you are offline or behind a firewall, the check fails

silently and the application continues normally.
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The updater queries the GitHub Releases API for the latest release tag and compares it against the currently running

application version.

3.2 Update Notification Dialog
When a newer version is found, a notification dialog appears with the following information:

• Current version and available version displayed side by side

• Release notes for the new version (from the GitHub release body)

• Three action buttons:

• Download Update -- Opens the download URL in your default web browser

• Remind Me Later -- Dismisses the dialog; the check will run again next time

you launch the application

• Skip This Version -- Permanently ignores this specific version; no further

notifications will appear until a newer version is released

3.3 Manual Update Check
To check for updates at any time (bypassing the once-per-day throttle):

1. Click Help in the top menu bar.

2. Click Check for App Updates....

3. If a newer version is available, the update dialog appears immediately.

4. If you are already on the latest version, a brief confirmation message appears.

The manual check also bypasses the "skip this version" filter, so you will see updates even for versions you previously

skipped.

3.4 Skipping a Specific Version
If you choose Skip This Version in the update dialog, the application stores that version tag in your settings. It will not

prompt about that version again during automatic startup checks. However:

• If you run a manual check via Help > Check for App Updates, skipped versions will

still appear.

• If a newer version is released (beyond the one you skipped), you will be notified

about that newer version automatically.

3.5 How the Update Is Delivered
The update dialog does not perform an in-place upgrade. When you click Download Update, your web browser opens the

download URL (typically the .exe file attached to the GitHub release). You then:

1. Download the new Design_Suite.exe.
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2. Close the currently running instance of J∆S Engineering Suite.

3. Replace the old EXE with the new one (or place the new EXE in your preferred

location).

4. Launch the new version.

Your project files (.mep), settings, and license information are all stored separately from the EXE and are preserved across

updates.

3.6 Technical Details

Setting Value

Check frequency Once every 24 hours (automatic)

API endpoint GitHub Releases API (api.github.com)

Network timeout 10 seconds

User-Agent JAS-Engineering-Suite-Updater

Stored settings last_update_check (timestamp), skipped_version (tag)

4. Offline Help System

4.1 Overview
The Offline Help System provides instant, context-sensitive help for every tool in J∆S Engineering Suite. All help content is

embedded directly in the application -- no internet connection or external files are required.

4.2 Context-Sensitive Help (F1)
Press F1 while any tool window is active to open help specific to that tool. The system automatically detects which tool you

are using and displays the corresponding help entry. For example:

• Press F1 in the Duct Sizer to see duct sizing formulas, input descriptions,

ASHRAE/SMACNA references, and practical tips.

• Press F1 in the Ventilation calculator to see ASHRAE 62.1 VRP formulas,

space type ventilation rates, and zone effectiveness factors.

• Press F1 in the Psychrometric calculator to see humidity ratio formulas,

saturation pressure equations, and altitude correction notes.

If no specific help entry exists for the current tool, the Help Browser opens to the general help index.

4.3 Help Browser
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The full Help Browser is a searchable window with a tree-view sidebar and an HTML content panel. To open it:

• Press F1 when no specific tool window is focused, or

• Click Help > Help Contents... in the top menu bar.

4.3.1 Navigation

The left panel shows a category tree:

Category Example Tools

Load Calculations Energy Calculations (Room Loads), Building Analysis, Envelope Editor

HVAC Systems Duct Sizer, Pipe Sizer, Pump Calculator, Ventilation (62.1), ESP
Calculator

Equipment Chiller Selection, Boiler Selection, AHU Selection, Cooling Tower, VRF
Design

Plumbing Fixture Calculator, Gas Pipe Sizer, Water Heater Sizing, Storm
Drainage

Fire Protection Sprinkler Hydraulics, Fire Pump Sizing, Standpipe, Kitchen Hood

Energy Analysis 8760 Simulation, Appendix G, Unmet Hours, EUI Benchmarking

Compliance ASHRAE 90.1, Title 24, IECC, LEED, PHIUS

Controls Sequences of Operation, BACnet Design, Points List, DDC
Programming

Reports Report Engine, Equipment Schedules, NRCC Forms, TAB Reports

Specialty Cleanroom, Data Center, Healthcare, Lab Fume Hood,
Pool/Natatorium

Click any entry in the tree to display its help content in the right panel.

4.3.2 Search

The search box at the top of the Help Browser lets you find help entries by keyword. Type a search term and press Enter

(or click the Search button). All matching entries are highlighted in the tree and the first match is displayed.

Search matches against:

• Help entry title

• Description text

• Category name

• Formula text

• Reference standards

4.3.3 Bookmarks

You can bookmark frequently used help topics for quick access:

1. Open a help entry.
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2. Click the Bookmark button (star icon) in the toolbar.

3. The entry appears in the Bookmarks section at the top of the tree.

4. Click a bookmark to jump directly to that entry.

4.4 Help Content Structure
Each help entry includes the following sections (when applicable):

Section Description

Title Name of the tool

Description What the tool does and when to use it

Category Which sidebar group the tool belongs to

Formulas Engineering formulas used by the tool, with variable definitions

Inputs Each input field with description, units, and valid range

Outputs What the tool calculates and displays

References ASHRAE standards, code sections, and other references

Tips Practical engineering tips and common pitfalls

Related Tools Links to other tools that work with this one

4.5 Help Entries Coverage
The help database includes 48 entries covering all major tool categories:

• 3 Load Calculation entries (Room Loads, Building Analysis, Envelope Editor)

• 10 HVAC System entries (Duct Sizer, Pipe Sizer, Pump Calculator, Fan Laws,

Ventilation, ESP Calculator, Mixed Air, Glycol, Refrigerant Piping, Air Balance)

• 8 Equipment entries (Chiller, Boiler, AHU, Cooling Tower, VRF, Heat Pump,

Fan Coil, Unit Heater)

• 5 Plumbing entries (Fixtures, Gas Piping, Water Heater, Storm Drainage, Medical Gas)

• 4 Fire Protection entries (Sprinkler, Fire Pump, Standpipe, Kitchen Hood)

• 5 Energy Analysis entries (8760 Simulation, Appendix G, Part Load, Unmet Hours,

EUI Benchmarking)

• 5 Compliance entries (ASHRAE 90.1, Title 24, IECC, LEED, PHIUS)

• 4 Controls entries (Sequences, BACnet, Points List, DDC Programming)

• 2 Report entries (Report Engine, Equipment Schedules)

• 2 Specialty entries (Cleanroom, Data Center Cooling)

4.6 Troubleshooting
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Problem Solution

F1 does not open help Ensure a tool window has keyboard focus (click inside it first)

Wrong help topic appears The help system maps tool IDs to entries; close other tool windows so
only the desired tool has focus

Help Browser shows empty content This indicates the tool does not yet have a dedicated help entry; the
browser shows the index instead

5. Web Dashboard

5.1 Overview
The J∆S Engineering Suite web dashboard at https://jsengineeringsolutions.com provides browser-based project

management and team collaboration. You can view project data, share projects with colleagues, and manage your

account from any device with a web browser.

5.2 Logging In
1. Navigate to https://jsengineeringsolutions.com in your web browser.

2. Click Login in the top navigation bar (or go directly to the login page).

3. Enter the same email and password you use in the desktop application.

4. If two-factor authentication is enabled, enter the 6-digit code from your

authenticator app.

5. You are redirected to the Dashboard.

Your web account and desktop account share the same credentials. If you registered

in the desktop app, the same login works on the web, and vice versa.

5.3 Dashboard Overview
After logging in, the dashboard shows:

• Your Projects -- A list of all projects you own, with name, location, last

modified date, and quick action buttons (View, Share, Delete).

• Shared With You -- Projects that other team members have shared with you,

showing the owner name and your permission level (View, Edit, Admin).

• Create Project -- A button to create a new project from the web interface.

• Upload Project -- Upload a .mep file from your computer to the cloud.

5.4 Project Management
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5.4.1 Creating a Project

1. Click Create Project on the dashboard.

2. Enter the project name, number, and location.

3. Select the building type and code standard.

4. Click Create.

The project appears in your project list. You can then open it in the desktop application by downloading the .mep file, or

continue viewing it on the web.

5.4.2 Uploading a Project

1. Click Upload Project on the dashboard.

2. Select a .mep project file from your computer.

3. The file is uploaded and processed. Project data (rooms, systems, results) are

extracted and stored in the cloud database.

4. The project appears in your project list.

5.4.3 Viewing a Project

Click View on any project to open the Project Detail page, which has four tabs:

Rooms Tab:

• Lists all rooms with name, space type, area, and calculated loads.

• Sortable columns.

• Search/filter by room name or space type.

Systems Tab:

• Lists HVAC systems with type, total cooling, total heating, and total CFM.

• Shows system-to-zone-to-room hierarchy.

Results Tab:

• Summary of calculation results: total cooling (tons), total heating (MBH),

total CFM, building EUI.

• Charts showing load breakdown by category (envelope, people, lighting, equipment,

ventilation, infiltration).

Compliance Tab:

• Code compliance status (pass/fail) for the selected standard.

• Individual check details with code references and margins.

5.4.4 Sharing a Project

1. Click Share on any project you own.

2. Enter the email address of the team member you want to share with.
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3. Select the permission level:

• Viewer -- Can view project data but not modify.

• Editor -- Can view and modify project data.

• Admin -- Full access including sharing with others.

4. Click Share.

5. The recipient will see the project in their "Shared With You" section.

5.4.5 Deleting a Project

1. Click Delete on any project you own.

2. Confirm the deletion in the confirmation dialog.

3. The project and all associated data are permanently removed.

Deleting a project from the web dashboard does not affect your local .mep file.

5.5 Team Collaboration
The web dashboard includes team collaboration features:

• Team Members -- View and manage team members (Admin accounts only).

• Activity Feed -- See recent project activity (uploads, shares, modifications).

• Role Management -- Assign roles (Admin, Member, Viewer) to team members.

5.6 Account Settings
Click your profile icon or navigate to Account Settings to:

• Change Password -- Update your login password.

• Enable/Disable 2FA -- Toggle two-factor authentication.

• API Key Management -- View and regenerate your API key for programmatic access.

• License Information -- View your current license status and expiration.

5.7 Troubleshooting

Problem Solution

Cannot log in Verify you are using the same credentials as the desktop app. Try
resetting your password.

Project data does not appear Ensure the project was uploaded after calculations were run.
Re-upload if needed.

Shared project not visible Ask the owner to verify the share and check that the correct email
address was used.

2FA code rejected Ensure your authenticator app clock is synchronized. The same TOTP
secret works for both web and desktop.
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6. IECC 2024 Compliance Module

6.1 Overview
The IECC 2024 module provides full compliance checking for the International Energy Conservation Code, 2024 edition. It

covers both commercial and residential buildings and supports all three compliance paths: Prescriptive, Performance, and

Energy Rating Index (ERI).

Access: Tools menu > Code Compliance > IECC 2024

6.2 Six-Tab Interface
The module uses a tabbed interface for organized data entry and review:

Tab Description

Project Info Building type (commercial/residential), climate zone (all 18 ASHRAE
zones), state adoption status, compliance path selection

Envelope Wall/roof/floor U-factors, window U-factor and SHGC, air leakage
rates. Checks against C402 (commercial) or R402 (residential)
requirements

Mechanical Equipment efficiencies, economizer requirements, ventilation, duct
insulation. Checks C403/R403

Lighting Lighting power density by space type, automatic controls. Checks
C405 requirements

SWH Service water heating equipment efficiency, pipe insulation. Checks
C404/R404

Results Overall pass/fail, individual check details with code references, C406
additional efficiency options

6.3 Key Features
• 50-state adoption tracking: Shows whether IECC 2024 is adopted, pending, or

using an older edition in each state.

• C406 additional efficiency packages: Select from 10 options including enhanced

envelope, HVAC performance, lighting, on-site renewables, and more.

• ERI targets: Calculates the Energy Rating Index target for residential buildings

by climate zone.

• COMcheck JSON export: Export compliance data in COMcheck-compatible format for

submission to building departments.

• Compliance report generation: Generates a formatted report with all checks,

code references, and pass/fail status.
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7. Equipment Performance Curves

7.1 Overview
The Equipment Performance Curves module provides manufacturer-specific performance data for 14 equipment types,

enabling accurate energy simulation using EIR-fT (energy input ratio vs. temperature), EIR-fPLR (energy input ratio vs.

part load ratio), and CAP-fT (capacity vs. temperature) curves.

Access: Tools menu > Equipment > Performance Curves

7.2 Supported Equipment Types
• Air-cooled chillers (scroll, screw)

• Water-cooled chillers (centrifugal, screw, absorption)

• Rooftop units (cooling, heat pump)

• Boilers (non-condensing, condensing)

• Air-source heat pumps

• Ground-source heat pumps

• Fan coil units

• Cooling towers

7.3 Key Features
• Coefficient editor: View and edit biquadratic/cubic curve coefficients with

immediate plot updates.

• IPLV/NPLV calculation: Per AHRI 550/590, calculates integrated part-load values

using the standard 25%/50%/75%/100% weighting.

• Curve fitting: Import manufacturer test data (entering/leaving temperatures and

capacity/EIR values) and fit performance curves using least-squares regression.

• Visualization: Interactive matplotlib plots showing performance vs. temperature

and part-load ratio.

• Integration: Performance curves feed directly into the 8760-hour energy

simulation module for accurate hourly equipment modeling.

8. Chiller Plant Sequencing

8.1 Overview
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The Chiller Plant Sequencing module simulates and compares different chiller staging strategies to optimize plant

efficiency over a full year.

Access: Tools menu > Equipment > Chiller Sequencing

8.2 Five Staging Strategies

Strategy Description

Lead/Lag Fixed sequence; one chiller starts first, others stage on at fixed load
thresholds

Load-Based Stages chillers based on current building load and each chiller's
capacity

Efficiency-Based Selects the combination of chillers that produces the lowest kW/ton at
current conditions

Runtime Equalization Rotates lead chiller to equalize total operating hours across the plant

Demand Limiting Reduces chiller stages during utility demand response events or peak
demand periods

8.3 Five-Tab Interface

Tab Description

Plant Config Number of chillers, capacity and type of each, primary pump sizing

Strategy Select and configure staging strategy, set staging thresholds

Load Profile Enter or import hourly building cooling load (8760 values)

Results Hourly simulation results, monthly energy breakdown, NPLV
comparison

Optimization Compare all strategies side-by-side, identify optimal sequencing

8.4 Key Outputs
• Annual chiller plant energy (kWh)

• Plant NPLV (kW/ton at integrated part-load conditions)

• Monthly energy and peak demand charts

• Per-chiller operating hours and start/stop counts

• Strategy comparison table with annual cost estimates

9. Enhanced Duct Sizing

9.1 Colebrook-White Friction Factor
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Version 1.2 upgrades the duct sizing engine from the Swamee-Jain approximation to the Colebrook-White iterative friction

factor solver, providing more accurate results that match ASHRAE Fundamentals duct friction charts exactly.

The solver uses 20 iterations of the implicit Colebrook-White equation:

1/sqrt(f) = -2.0 * log10(e/(3.7*D) + 2.51/(Re*sqrt(f)))

Where f is the Darcy friction factor, e is surface roughness (0.0003 ft for galvanized steel), D is hydraulic diameter, and Re

is Reynolds number.

9.2 Darcy-Weisbach Pressure Drop
Pressure drop is now calculated using the exact Darcy-Weisbach equation instead of empirical curve-fit approximations:

dP = f * (L/D) * (rho * V^2) / 2

9.3 Temperature-Dependent Viscosity
Air viscosity is now corrected for temperature using Sutherland's law, improving accuracy for high-temperature exhaust

duct sizing and cold supply air conditions.

9.4 Dual-Constraint Sizing
The new size_duct_dual_constraint() function simultaneously enforces both velocity and pressure drop limits, selecting

the smallest duct size that satisfies both constraints.

All results are backward-compatible with previous versions. Existing projects will produce the same or slightly more

accurate results.

10. Enhanced Psychrometrics

10.1 Hyland-Wexler Saturation Equations
Version 1.2 uses the Hyland-Wexler saturation pressure equations from ASHRAE Research Project RP-216, which are the

reference equations used in ASHRAE Fundamentals.

10.2 Improved Dew Point Calculation
A new dew_point_from_pv() function uses ASHRAE's 5th-order polynomial for direct dew point calculation from partial

vapor pressure, eliminating iterative convergence issues at extreme conditions.

10.3 Tighter Wet Bulb Convergence
The wet bulb temperature solver now uses a convergence tolerance of 1e-7°F (previously 1e-4°F) and up to 50 iterations

(previously 40), providing more accurate results for psychrometric charting and coil selection.
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11. Authenticated Downloads

11.1 Overview
Downloads from the J∆S Engineering Suite website are now gated by user account authentication for protected files, while

free standalone tools remain publicly accessible.

11.2 Protected Downloads (Require Account)
• Design Suite desktop application (Design_Suite.exe)

• Revit add-in packages (JS_Revit_DesignSuite.zip, JS_Revit_ClashDetection.zip, JS_Revit_MEPTools.zip)

• User guide PDFs

• Sample projects and documentation ZIPs

11.3 Free Downloads (No Account Required)
• PsychChart Pro standalone calculator

• DuctSizer Pro standalone calculator

11.4 How It Works
Protected downloads use pre-signed S3 URLs with 15-minute expiry. When you click a download button while logged in,

the website requests a temporary download link from the API server, which generates a time-limited URL. This ensures

that only authenticated users can access the files while keeping the download process seamless.

12. EnergyPlus Integration

12.1 Overview
The EnergyPlus Integration module generates complete EnergyPlus IDF input files from your JAS project model and

parses simulation results. It also supports ASHRAE 90.1 Appendix G analysis with automated baseline generation and

4-rotation comparison.

Access: HVAC Load Calculations > EnergyPlus Simulation

12.2 Key Features
• IDF Generation: Converts JAS Building/Zone/Room/Wall/Window models into complete EnergyPlus IDF files with

geometry, constructions, schedules, HVAC templates, and output variables

• EPW Weather Management: Auto-downloads EPW files from climate.onebuilding.org by state, cached locally

• Appendix G Compliance: Generates proposed + 4 baseline IDFs (0/90/180/270 degrees), runs all 5 simulations,

calculates PCI and LEED EAc2 points
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• Result Parsing: Reads ESO, CSV, and ERR output files for energy breakdown, unmet hours, zone peaks, and

monthly data

• LEED Template Export: Generates formatted LEED EAc2 energy model summary report

Note: Requires EnergyPlus installed separately (free from energyplus.net). The module auto-detects installations via

PATH, registry, and common directories.

13. Multi-Objective Design Optimizer (NSGA-II)

13.1 Overview
The Design Optimizer uses NSGA-II (Non-dominated Sorting Genetic Algorithm II) to explore 122 design variables across

envelope, HVAC, controls, lighting, and renewables to find Pareto-optimal building designs that balance energy cost,

carbon emissions, first cost, and thermal comfort.

Access: HVAC Load Calculations > Design Optimizer (NSGA-II)

13.2 Key Features
• 122 Design Variables: Grouped across 16 categories including envelope U-values, WWR, HVAC system type,

equipment efficiency, control setpoints, lighting, renewables, and building form

• 6 Objective Functions: Annual energy cost, carbon emissions, first cost premium, thermal comfort (PPD), annual

energy use, and life-cycle cost

• Pareto Front Visualization: Interactive scatter plot of non-dominated solutions with TOPSIS ranking

• Baseline Comparison: Side-by-side comparison of optimized vs. baseline design

• Export: TXT report, CSV Pareto front, JSON best solution

14. A2W Heat Pump Cascade System

14.1 Overview
The Air-to-Water Heat Pump (AWHP) Cascade module models distributed WSHP loop systems served by central

air-to-water heat pumps, with supplemental boiler for cold-climate backup and optional dedicated heat recovery chiller.

Access: HVAC System Design > A2W Heat Pump System

14.2 Key Features
• 12 AWHP Catalog Models: Trane Ascend ACX, Carrier AquaSnap 30AWH, Daikin EWAQ, Mitsubishi CAHV,

Multistack MS-A (14-100 tons)

• 13 WSHP Models: ClimateMaster, Bosch, Bard (0.75-10 tons)
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• 8760-Hour Simulation: Hourly AWHP performance with OAT derating, PLR correction, defrost penalty, LWT

adjustment, loop temperature dynamics, pump VFD

• Auto-Sizing Wizard: Selects AWHP model/quantity, sizes WSHPs per zone, calculates loop parameters, identifies

balance point and supplemental boiler capacity

• Conventional Comparison: Automatic chiller+boiler baseline comparison with energy, cost, and carbon savings

15. Global Weather Database

15.1 Overview
Extends the 523 US weather station database with 1,283 international weather stations across 113 countries, providing

ASHRAE-level design conditions for global projects.

Access: References & Standards > Global Weather Database

15.2 Key Features
• 1,283 Stations: Major cities worldwide with design cooling/heating DB/WB, HDD/CDD, humidity ratio, wind speed

• Koppen and ASHRAE Zone Mapping: Each station mapped to Koppen climate classification and ASHRAE climate

zone (0A-8)

• Proximity Search: Find stations near any latitude/longitude using Haversine distance

• Climate Comparison: Compare up to 10 stations side-by-side with all design conditions

• Monthly Temperature Model: Sinusoidal annual profile with 8760 hourly generation for simulation use

16. Weather-Driven Infiltration

16.1 Overview
Provides 6 advanced infiltration models that go beyond the simple ACH input, calculating air infiltration based on weather

conditions, building characteristics, and envelope tightness.

Access: Ventilation & Air Systems > Weather-Driven Infiltration

16.2 Available Models

Model Description

ASHRAE Stack Effect Neutral pressure plane with temperature-driven stack effect

Wind-Driven Wind pressure coefficients on building surfaces

Combined Stack + Wind Root-sum-square combination per ASHRAE
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Model Description

LBNL Sherman-Grimsrud Whole-building leakage model from Lawrence Berkeley

AIM-2 (Alberta) Enhanced stack/wind model with improved low-wind accuracy

Door Opening Vestibule/revolving/air curtain infiltration through entries

17. Green Certification Manager (LEED/BREEAM/WELL)

17.1 Overview
Automated credit analysis and submission documentation for 4 certification systems with 114 total credits mapped to

project data.

Access: Compliance & Sustainability > Green Certification (LEED/WELL)

17.2 Certification Systems

System Credits Max Points

LEED v4.1 BD+C 30 (9 prerequisites + 21 credits) 67

LEED v4.1 O+M 15 (7 prerequisites + 8 credits) 42

WELL v2 33 (9 preconditions + 24 features) 44

BREEAM International 2024 36 (4 prerequisites + 32 credits) 93

17.3 Key Features
• Automated Credit Evaluation: Maps 70+ project data inputs to certification requirements

• Energy Performance Rating: ASHRAE 90.1 Appendix G PCI calculation with LEED EAc2 point lookup

• Multi-Certification Comparison: Run all 4 systems simultaneously to compare achievable levels

• Gap Analysis: Identifies non-achieved credits sorted by opportunity

• Submission Package Export: Generates formatted documentation with per-credit analysis

18. Manufacturer Data Import

18.1 Overview
Import equipment performance data from manufacturer selection software and certified rating databases, with curve fitting

and performance library management.
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Access: Plant Equipment > Equipment Data Import

18.2 Supported Formats

Format Source Data

TOPSS XML Trane TOPSS Chiller/RTU performance curves, capacities,
efficiencies

eCAT CSV Carrier eCAT Equipment ratings, part-load data

AHRI CSV AHRI Directory Certified ratings (cooling, heating, IPLV,
HSPF2)

Custom CSV Any User-defined equipment performance data

18.3 Key Features
• Bi-Quadratic Curve Fitting: Least-squares regression for EIR-fT, CAP-fT, and EIR-fPLR curves

• IPLV/NPLV Calculation: Per AHRI 550/590 with 25/50/75/100% weighting

• Equipment Library: Save, search, compare, and manage imported equipment

• Performance Visualization: Interactive capacity vs. temperature and efficiency vs. PLR charts

19. HVAC Schematic Editor

19.1 Overview
A visual node-graph editor for designing HVAC system schematics with drag-and-drop equipment placement, automatic

port wiring, and template-based system generation.

Access: HVAC System Design > HVAC Schematic Editor

19.2 Key Features
• 35 Equipment Components: AHU, RTU, chillers, boilers, cooling towers, heat pumps, VRF, valves, sensors, and

more across 8 categories

• Color-Coded Piping: Blue (CHW), red (HW), green (CW), orange (refrigerant), gray (duct), purple (controls)

• 7 System Templates: VAV with plant, VRF+DOAS, WSHP loop, RTU, fan coil 4-pipe, DOAS+radiant, central plant

• Validation Engine: Checks for unconnected ports, missing pumps, and zones without supply air

• Export: PNG, PDF, CSV equipment schedule, JSON (full round-trip save/load)

20. PDF Floor Plan Sketcher
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20.1 Overview
Load PDF floor plans as background images and sketch rooms, windows, and doors directly on top. Calibrate scale from a

known dimension, then export traced room data for HVAC load calculations.

Access: Enterprise Tools > Floor Plan Sketcher

20.2 Key Features
• PDF Background: Load architectural floor plans as canvas background

• Room Tracing: Draw polygon rooms with click-to-place vertices

• Scale Calibration: Set a known dimension (e.g., "this wall is 30 ft") to calibrate all measurements

• Window/Door Placement: Place windows and doors on room walls with orientation

• 3D Wireframe: Extrude traced rooms into 3D wireframe view with adjustable ceiling height

• Export to Load Calc: Export room data (area, perimeter, windows, doors) to the load calculation engine

21. Enhanced Title 24-2025

21.1 Battery Storage Sizing
New Section 130.11(b) compliance for battery energy storage systems. Implements the 5 kWh per 1 kW PV rule with

exemptions for buildings under 10,000 ft2 and warehouses. Validates both energy capacity (kWh) and power rating (kW).

21.2 Heat Pump Requirements
Mandatory heat pump space heating for systems under 240 kBtuh in Climate Zones 1-7. Includes COP validation by

capacity range per 5 efficiency tiers at 47F rating conditions.

21.3 IAQ Ventilation Updates
19 space types aligned to ASHRAE 62.1-2022 ventilation rates (cfm/person + cfm/ft2), MERV 13 minimum filtration, and

CO2 monitoring requirements with DCV determination.

22. Enhanced PCM Modeling

22.1 Hysteresis Modeling
PCM materials now include separate melting and solidification temperatures, capturing the real-world behavior where

PCMs freeze at a lower temperature than they melt (typically 2-4F difference).
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22.2 Expanded Material Database
The PCM database has been expanded from 6 to 17 materials including Rubitherm paraffins (RT18, RT21, RT35, RT42),

salt hydrates (S32, S44), PureTemp bio-based (PT29, PT37), and Armstrong Templok ceiling tiles.

22.3 Wall Layer Simulation
New simulate_pcm_wall_hourly() function performs 8760-hour simulation of PCM integrated into building envelope walls

or ceilings using lumped-capacitance thermal modeling with explicit Euler time stepping.

23. Summary of All v1.2 Changes

Feature Description Access

CLI Runner Headless load calcs, energy sims, compliance
checks, and parametric sweeps

python cli_runner.py

Auto-Updater Checks GitHub Releases once per day;
Download, Remind Later, or Skip Version

Help > Check for App Updates

Offline Help F1 context-sensitive help with 48+ entries,
searchable browser, bookmarks

F1 key; Help > Help Contents

Web Dashboard Browser-based project management, sharing,
team collaboration

jsengineeringsolutions.com

IECC 2024 Full commercial and residential compliance
with 50-state adoption tracking

Compliance & Sustainability

Equipment Curves 14 equipment types with EIR/CAP curves,
IPLV/NPLV, curve fitting

Plant Equipment

Chiller Sequencing 5 staging strategies, 8760-hour simulation,
NPLV comparison

Plant Equipment

Duct Sizing Colebrook-White friction factor,
Darcy-Weisbach pressure drop

Sizing Tools

Psychrometrics Hyland-Wexler equations, improved dew point
and wet bulb accuracy

Additional Tools

Authenticated Downloads Protected downloads require account; free
tools public

Website

EnergyPlus Integration IDF generation, EPW management, Appendix
G compliance, LEED template

HVAC Load Calculations

Design Optimizer NSGA-II with 122 variables, 6 objectives,
Pareto front, TOPSIS ranking

HVAC Load Calculations

A2W Heat Pump Cascade AWHP + WSHP loop with 8760 simulation,
auto-sizing, 25 catalog models

HVAC System Design

Global Weather 1,283 international stations across 113
countries with ASHRAE design data

References & Standards

Weather Infiltration 6 advanced models: stack effect, wind, LBNL,
AIM-2, door opening

Ventilation & Air Systems
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Feature Description Access

Green Certification LEED v4.1, WELL v2, BREEAM 2024 with
114 credits, submission packages

Compliance & Sustainability

Manufacturer Import TOPSS XML, Carrier eCAT, AHRI CSV with
curve fitting and IPLV calculation

Plant Equipment

HVAC Schematic Editor Visual node-graph with 35 components, 7
templates, validation, export

HVAC System Design

Floor Plan Sketcher PDF sketch-over with room tracing, scale
calibration, 3D extrusion

Enterprise Tools

Title 24-2025 Battery storage, heat pump requirements, IAQ
ventilation updates

Compliance & Sustainability

PCM Enhancement Hysteresis modeling, 17 materials, wall layer
8760 simulation

Emerging Technologies

Heat Balance Method ASHRAE Heat Balance Method load
calculation (alternative to CLTD/CLF)

HVAC Load Calculations

This guide covers J∆S Engineering Suite v1.2. For the latest information, visit https://jsengineeringsolutions.com or contact

support.

Copyright 2026 JS Engineering Solutions. All rights reserved.
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